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How to order
Provides phone numbers and mailing addresses to use for ordering your 
blueprints.

For more information please read:

How To Order Blueprints
Information About Blueprints
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Billing/Shipping
If you want to fax or mail in your order, use this tab to fill out your 
information.
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Order form
Shows how much the blueprints cost. You can also print or fax your order 
from this screen by clicking on the Print or Fax buttons.

For more information please read:

How Many Sets Of Plans Will You Need?
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Navigation

To change areas, click on tabs that are at the top of the screen:

File
Search
View
Order
Help

To begin your search, click on the 'Search' tab. Then you will see several sub-
tabs you can click on to choose your search criteria:

Criteria -- choose your main search criteria
Features -- choose rooms and additional features
Architecture -- select architectural preferences
Designers -- select your favorite designers
Other -- search by plan number, or find all homes

After you have entered your search criteria, Click on the View tab to see the 
homes that satisfy your search criteria. In the view screen, click on the 
buttons at the bottom of the screen to change homes or view different 
pictures.

To print plans, click on the printer button at the bottom of the View screen.

After you find a home plan, click on the Order Tab to see information on how 
to order the home's blueprints. 
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Search
Click on the Search tab to search for homes. When you click on the search 
tab, you are shown several sub-tabs. Click on these sub-tabs to choose your 
search criteria:

Criteria
Features
Architecture
Designers
Other
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View
When you click on the View tab, you are shown the homes that satisfy your 
search criteria. From the View screen, you can also:

Bookmark your favorite homes.
Zoom in on pictures to magnify them.
Print plans

Shown below are the buttons you can use in the View screen.

 First home plan
Button takes you back to the first plan.

 Tour of homes slide show 
Displays homes, and has special animated effects and acoustical guitar 
music. Promote your business using this feature!!

 Outline of homes
Shows a list of plans you are viewing. You can also use the feature to 
jump to another plan by clicking on the plan number in the outline. 
When viewing the outline, you can also adjust the size of the columns in
the outline. While viewing the outline,    if you scroll to the left, you'll see
other details such as the design firm.

 View bookmarked plans
This button will cause your bookmarked plans to be shown in the view 
screen.

 View matching plans
This button shows you all plans which meet the current search criteria.

 Next plan
Shows the next home.

 Previous plan
Shows the previous home.

 Bookmark current plan
If you like a home, use this button to put a bookmark on it.



 Unbookmark current plan
When you see this button, you know the home has been bookmarked. If
you click this button, the bookmark is removed from the home.

 Front view
Shows a home's front exterior picture.

 Rear view
Shows a home's rear exterior picture.

 Side view
Shows a home's side exterior picture.

 Main floor plan
Shows a home's main floor plan. The main floor is the ground level floor.

 Upper floor plan
Shows a home's upper floor plan.

 Lower floor plan
Shows you the lower floor plan. The lower floor is usually partially 
underground, or for multi-level homes it's the bottom floor of the home.

 Third floor plan
Shows a home's third floor plan.

 Interior view
Shows picture of a home's interior.

 Alternate plan
Shows options or alterations available for a plan.

 Details
Shows a home's description.

 Specifications.
Shows a home's specifications (square feet, number of rooms, garages, 
etc.)

 Turn two picture view on



Lets you view 2 pictures in the viewing window. You can adjust the size 
of each viewing window by dragging the separator bars between the 
windows. To change pictures, click on viewing buttons (such as front 
view, rear view, etc.) When you change pictures, the picture is 
displayed in the active window.

 Turn single picture view on
Changes viewing back to a one-picture viewing window.

 Turn reverse on
This button shows mirror images for the current home's pictures.    This 
is helpful to see how the home would look if you want to reverse the 
plan.

 Turn reverse off
Resets the pictures back to normal picture display.

 Print plans
Lets you print feature sheets or full page pictures for a home. You can 
also print reverse pictures for a home. If you experience printer 
problems, then click Printer problems & solutions or Technical Support 
for assistance.

 Order plans
This button shows you pricing information for a home's blueprints. You'll
need to purchase blue prints before constructing the home. This 
software shows you simplified drawings to help you visualize the home. 
The blueprints for the home provide much greater detail and will help 
your builder when constructing the home.
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Search Criteria
You can click on the criteria tab to enter your main search criteria:

Type of home:

Single family homes are occupied by one family
Multi family homes are shared by 2 or more families (such as condos, 
duplexes, or townhouses)

Style:

The style criteria determines your home's layout. A 'story' is an above-
ground floor. Some homes have floors below ground level (such as a 
finished basement), but those floors aren't considered a story.

Hint: If you are looking for a 2-story home, remember to also look at 
the 1-story homes. Some 1-story homes may have finished basements 
that might suit your needs (or you could finish the basement to create a
home with 2 floors).

1-story homes have one floor above ground level.

2-story homes have 2 floors above ground level.

3-story homes have 3 levels of windows above ground level (when 
viewed from the front of home). A 3-story home might only have 2 
floors, but it has the appearance of 3 floors when viewed from the front.
Many of these homes could also be considered 2-story homes. Because 
of this, if you search for 2-story homes, we will also show you 3-story 
homes.

Multi-Level homes have floors at varying levels. Common names for 
multi-level homes include: quad-level, tri-level, bi-level, split foyer, split-
level.

Number of:

You can choose how many rooms you want:

Bedrooms are the rooms used as sleeping quarters. Sometimes a 
home might have rooms that could easily be converted into a bedroom 
(such as a den) and those    rooms may be considered potential 
bedrooms.



Full baths are bathrooms that have a shower or bath tub.

Half baths are bathrooms which don't have a shower or tub

Car Stalls are garages or carports. A stall is a place to store one car. 
For example if you want a 3-car garage, then you would search for 3 
stalls. Remember, sometimes you can customize a plan to change the 
number of car stalls. Because of this, you may want to broaden your 
search range. For example if you want a home with 2 car stalls, you 
may want to search for homes that have 1 to 3 car stalls. By doing this 
you may find a home that is perfect for you once you modify its garage.

Room Location:

You can pick your floor preferences for the master bedroom and the 
laundry room

Hints: Laundry rooms are small areas. You can often customize a plan 
to accommodate your laundry room preference. Because of this, you 
might want to avoid searching for the laundry location.

If you are searching for a multi-level home, you should avoid using 
room location criteria. This is because the varying floor levels in 
multi-level homes may have desirable room locations that you 
might not find when using this criteria. Also it's difficult to define 
'locations' in multi-level homes and you might misinterpret this 
search. We recommend you avoid searching for room locations in 
multi-level homes.

Your search can look for these locations:

Main floor is the home's ground level floor. (Note: multi-level 
homes usually have lower floors and upper floors but no ground-
level floor.)

Upper floor is the floor above the main floor (or the top floor in a 
multi-level home)

Lower floor is typically below ground or partially below ground 
level (or the bottom floor in a multi-level home)

Main & Upper floor indicates you want two master bedrooms (one
on each floor)

Dimensions:



This criteria lets you search for the size of your home.

Total finished square feet is the total square footage of all 
finished areas of the home.

Main floor square feet minimum: Most people should leave this 
criteria set to zero. You might use this criteria if your subdivision's 
covenant requires homes to have a minimum main floor square 
footage. If so, input the minimum square footage needed to satisfy 
your subdivision's requirements. Remember, you can often 
customize a plan. You may want to use a number that is lower the 
your covenant's requirements. If you find a home you like but it's 
too small, you may be able to enlarge it to satisfy your covenant 
requirements. If you use this criteria, the homes found will have a 
floor with square footage that is equal to or larger than the square 
footage you entered. Usually a home's largest floor is considered 
the main floor. However, once you find your home, you should 
double check the square footage specifications to be sure the home 
satisfies your needs.

Building site area: If you already own a piece of land, you can 
search for homes that will fit on your land. Remember, your land's 
buildable area might be reduced by easements and setbacks. After 
you've determined the buildable area, you enter the maximum area 
you have for building the home.

Width is the maximum land size available for building a home 
(measured from one side of the home to the other side).

Depth is the maximum land size available for building a home 
(measured from the home's front to back).

Hints: 

If you don't have land yet, then make the width and depth large 
(such as 150 feet by 150 feet).

You may want to round up your width and depth. (For example if 
your buildable width is 40'3" you might want to enter 41 feet in the 
depth. If you enter only 40 feet, you might eliminate some homes 
that would still fit on you land. Also, you may want to have your 
search range be a few feet larger than your buildable area, because 
you can sometimes customize a home plan. A home that is too large
for your land might still be suitable if you reduce the size of the 
home.
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Search Features
You can click on the Features sub-tab to search for rooms and additional 
features. You will use slider dials to choose features that interest you.

Hint: When searching for features, only make features a Must if it is required
(choosing a Must might eliminate homes you would really like -- you'll find 
more homes if you pick wants instead of Musts). Also, many home plans can 
be customized. You may be able to modify a plan to suit your requirements.

Rooms:

Living Room is a formal room for entertaining guests. Sometimes living 
rooms are called other names such as the "parlor" or "receiving room." 
Also, you may be able to customize a plan and use the living room for 
another purpose, such as a den, an extra bedroom, or even a formal 
dining area.

Family Room is an informal entertaining room. Generally homes with a 
living room also have a family room. If a home doesn't have a living 
room, then usually the informal entertaining area is larger and is known 
as a Great room.

Great Room is an informal entertaining area of a home. Homes with 
Great rooms usually don't have living rooms. Sometimes people 
consider a large family room to be a 'Great room.' Because of this, a 
search for Great rooms will sometimes show homes with large family 
rooms. Great rooms are sometimes called other names such as Media 
Rooms or Recreation room.

Dining Room is the formal dining area of a home. Sometimes you can 
customize a plan to add or change the dining room area. For example 
you may be able to change the living room into a dining room.

Breakfast Room is the informal dining area of a home.

Nursery/Den is a room that is typically on the main floor or near the 
master bedroom. Sometimes you can customize a plan and convert 
another room (such as the living room or bedroom) into a Nursery/Den. 
The Nursery/Den is sometimes called other names such as: study, 
library, or guest room.

Additional Features:

Balcony/Loft are locations in which an upper floor overlooks another 



floor. Sometimes these areas are called "bridges." Balcony/Lofts are 
often located near stairways and often overlook entry foyers or Great 
rooms

Double staircase refers to having 2 or more separate staircases in a 
home or a staircase that has multiple stairways leading to it.

Fireplace is a device for burning wood. If a plan doesn't have a fireplace,
you can often customize a plan to add a fireplace.

High Ceiling: Standard Ceilings are 8 feet high. If any room has a ceiling
that is 9 feet tall or higher, then the home has a high ceiling.

Porch is an area located towards a home's exterior and is sheltered by a
roof. Most porches are open, but some have screens. People who like 
large porches often like Country homes or Victorian homes. (You can 
search for those styles in the Architecture screen.)

Separate bath and shower means that the home has a bathroom that 
contains a separate bath tub and a separate shower. Usually, the 
bathroom has a large tub such as a garden tub or whirlpool bath.

Side garage means the home's garage doors are less visible (or even 
hidden) when viewing the front of the home. Remember, you can 
sometimes customize a home and change its garage into a side garage 
(for example move the location of the garage doors to a different wall of
the garage).
 
Sloping ceiling: refers to homes that have ceilings with unique angles, 
such as cathedral ceilings, tray ceilings, or arched ceilings.

Walk-in closets are larger closets that have enough room for a person to
walk into it.

Wall of windows are walls where the majority of a wall has windows, or 
a wall that has windows stacked above windows. Also, large bay 
windows are sometimes considered a wall of windows.

Wheelchair accessible homes typically have wider hallways and 
doorways. Also, the bathrooms and kitchens have extra room for 
maneuvering a wheelchair. You may be able to customize a home to 
make it wheelchair accessible.
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Search Architecture
Click on the Architecture tab to search for your home's exterior appearance. 
You will use slider dials to choose your architectural preferences.

Note: Architecture sliders only allow you to specify a 'want' priority. (1= low 
priority, 9 = high priority, a zero means no preference.)

Hint: Many home plans can be customized. If you like a plan, but want a 
different exterior look, this can often be accomplished by making changes to 
the windows, roof line, and exterior details. The most important part of a 
home plan is the floor plan. Remember, you'll spend 90% of your time on the
inside of your home. The floor plan should be the main thing you look at 
when shopping for a home plan.

Shown below is an example of two homes that have the same floor plan. As 
you can see, major changes can be made to a home's exterior without 
affecting its floor plan. After you find your ideal plan, you can often 
customize its exterior to suit your tastes.

 



If you want to find all of the homes with a particular architecture style, you 
might want to use the maximize criteria button found in the Other tab.

Here are the styles you can search for.

Contemporary homes have a more modern look.

Country homes have porches, and are sometimes called farm houses. If 
you like large porches, you may also want to look at Victorian homes.

English homes typically have Tudor accents.

European homes include: French, Italian, or other styles characteristic of
European homes

New England    homes have styles characteristic of homes found in 
North-Eastern United States. This includes: Cape Cods, Salt boxes, and 
Early American designs.

Sloping Lot homes are designed for sloping land or hill sides.

South Western homes often have: stucco exteriors, tile roofs, arched 
openings, and court yards. This architectural category includes these 
styles: Mission style, Santa Fe style, and Spanish architecture.

Southern style homes include: Georgian style, plantation style, and 
Federal style homes. 

Vacation homes are designed for scenic locations, or are smaller homes 
suitable for weekend get-aways.



Victorian homes are known for their ornate exteriors and large wrap-
around porches. Sometimes these homes are known as 'Ginger Bread' 
homes because of their detailed exterior accents. If you like large 
porches, you may also want to search for Country style homes.
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Search Designers
Lets you search for homes that created by your favorite designers.

Hints: Often, plans from the same designer have a similar style to them and 
you may find a home you'll love simply by reviewing other plans from your 
favorite designer.

You can determine which designer created the plan, by looking in the 
specifications window. Also, you can see the designer of a plan by clicking on
the plan outline button and scrolling to the right-most column in the outline.

You will use slider dials to choose designers that interest you.
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Search Other
The 'Other' tab lets you do special searches such as:

Plan number search -- If you already know the plan numbers for homes 
you want to view, you can type a list of plan numbers and then hit the 
Find button. Then the software retrieves those plans and you can click 
on the View tab to see them. 

Maximize Criteria button is used to find everything. This is helpful if you
want to find all homes that have a particular feature. For example, let's 
say you want to see all Victorian homes. To do this, you would click the 
Maximize Criteria button and then go to the Architecture Tab and search
for Victorian homes.

Restore Default Criteria button resets all criteria to the normal starting 
values. This button is helpful for resetting criteria after you've done a 
Maximize Criteria search.
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File
The 'File' tab lets you save your search criteria and bookmarks. Then the 
next time you run this software, you can easily load your criteria and 
bookmarks into the software.

This feature is especially helpful for Realtors® or Builders. For example, you 
can use this feature to create a preference file for each customer. Also, if you
typically sell certain types of homes, you can save your typical search 
criteria and then open your criteria when you use this software (instead of 
having to re-enter your search criteria each time).

Also you can Promote your business using this feature!! You can put 
bookmarks on the types of homes you like to sell. Then you can save your 
bookmarks and load them before giving a sales presentation. You can show 
customers your bookmarked homes from the view screen or create a 
powerful multimedia presentation with the Tour of Homes slide show. Also, 
the slide show is a great way to attract attention to your business at trade 
shows, home shows, or anyplace where you want people to notice you.

To save a file, type a file name in the file name field,    and then click on 
the Save button. (This causes your search criteria and bookmarks to be 
saved in that file).

To open a file, type the file's name in the file name field and click on the 
Open button.

Clear Bookmarks button causes your current bookmarks to be removed. 
This button won't affect any bookmarks you've saved to a file (unless you 
overlay the file by saving it again).

Turn Music On/Off button allows you to play music while finding your 
dream home.

Exit Plan Finder button causes the program to exit.

Copyright (c) 1996 AbbiSoft, Inc.    All rights reserved



Order
When you click on the Order tab you see pricing information for the home 
that is currently shown in the View screen.

The Order also has several sub-tabs you can click:

How to Order
Billing / Shipping
Order Form
Blueprint Info
Close:  Click on the Close tab to exit the order screen and return to the 
View screen.

If you enter information in the Billing/Shipping screen, your name and 
address information are saved so that you will not have to re-enter it on 
future orders. However, remember to always enter your credit number and 
shipping preference because that information is not saved by the software.

For information about blueprints read the article called 
Information About Blueprints.
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Your Best Decision
An important message from Ken Katuin, President of AbbiSoft, Inc.

A few years ago, I designed a home. I never realized how much work it would
take to design a blueprint.    I had to pick out the dimensions, the roof 
pitches, the window locations, and thousands of other details.

It takes hundreds of hours and thousands of dollars to design a blueprint. 
This is necessary because blueprints determine the quality of your home. 
Every aspect of your home, from the foundation to the roof, is influenced by 
blueprints.

Professionally designed blueprints are very important. Here's why:

They increase your life span, reduce stress, and they may save 
your marriage.      (I'm just kidding.) 
You will have more free time and fewer worries when an experienced 
designer creates your blueprints.

Competitive bids reduce your home's cost. When you provide builders
with detailed blueprints, you help them by reducing the unknowns. This 
can help you receive more accurate and competitive bids. This reduces the
chance of unexpected costs and you will know what you are getting. Also, 
it is easier to compare bids when each builder's price is based on the same
specifications.

Professional blueprints can reduce the cost of building your home.
Sometimes, people think a plan that is drawn by a lumberyard or builder is
the same as a blueprint from a professional designer. However, there may 
be many differences. A professional designer creates detailed blueprints 
and their business depends on the quality of their blueprints. Detailed 
blueprints can reduce the cost of building a home. Often, lumberyards and 
builders do not have enough time or resources to create detailed 
blueprints.

Professional blueprints reduce decisions. Professional blueprints 
usually have 8 to 12 pages of detailed information. A great deal of thought 
goes into these blueprints. A well-designed blueprint helps reduce the 
decisions you'll have to make when building your home.

You can start building sooner and reduce the time needed to build
your home. You can order blueprints for any of the homes on this CD-
ROM. In a few days you will receive professional blueprints and can start 
your home. Also, construction can proceed faster when you have fewer 



decisions. This is very important during times of rising lumber prices or 
unstable interest rates. A delay of a few months can easily add thousands 
of dollars to the cost of your home.

You help feed a designer. The cost of these blueprints is shared by 
many customers. Because of this, you can own professional blueprints for 
a very reasonable price. A blueprint's value comes from the hundreds of 
hours a skilled designer invests when creating it. By sharing their skills, 
these designers help you create a home for your family. You help a 
designer take care of their family by purchasing a blueprint.

You receive a license. When you buy a professional blueprint you 
receive a license. A license lets you legally build or modify a plan. 
Unfortunately, some people don't realize this. When a person builds or 
modifies a plan without buying the blueprints, they miss out on the 
benefits the blueprints would provide. They also violate copyright laws. 
Most importantly, they hurt the designers and their families. Violating 
copyright laws is a serious offense and can result in penalties of up to 
$100,000 per violation.

Many of these blueprints have already been used to successfully 
build other homes. The designers on this CD-ROM create blueprints that 
conform to national building codes. Building codes help make sure a home 
is safe to live in and is properly built.

You can create a custom home. It usually costs less to modify an 
existing plan than to design a new plan. By starting with these blueprints, 
you can design a custom home at a fraction of the normal design cost.

A well-designed home has a better resale value. These designers 
have years of experience. They know what people want in a home. This 
CD-ROM contains some of the nation's best-selling home plans.

A well-designed home is more comfortable and enjoyable. 
Professional designers think about many things when designing a home 
such as: aesthetics, traffic flow, and energy efficiency.

As you can see, a professionally designed blueprint can quickly pay for itself. 

Your home is the biggest investment you will ever make. It only makes sense 
to protect your investment by starting with a quality blueprint. One of the 
best decisions you can make is to create your home from a professionally 
designed blueprint.

The pictures on this CD-ROM will help you visualize the homes. To build a 
home, you will need the blueprints. The blueprints provide hundreds of 



additional details needed to build your home.

For important information about homes, please read my article Your Worst 
Mistake.

You can learn more about building a home by looking inside the booklet that 
came with your CD-ROM or by reading the article: Information About 
Blueprints. Those items also show examples of the drawings that come with 
professionally designed blueprints.

Please read: You Earn $10 By Saving Others $10. Please print that coupon 
and give it to others. We will send you $10 for each customer who buys our 
software using a coupon that you have given out. You will also receive $5 for 
customers who use a coupon for our plan search service. Our plan-search 
service helps people who don't have computers. If you know anyone who is 
shopping for a home, please give them a coupon.

If you know anyone whose occupation involves selling homes or land, or 
designing homes, then please show them the article: How to Gain 3 to 6 New
Customers Each Year.    Also, please give them a coupon.

Thank you for purchasing AbbiSoft's Home-Plan Finder(TM).

Sincerely,

Ken Katuin,
President, AbbiSoft, Inc.

An important note: These professionally designed blueprints conform to 
one or more of the industry's major national building standards in effect at 
the time they were drawn. However, due to the variety of local building 
regulations, your blueprint may need to be modified to comply with local 
requirements such as snow loads, energy loads, seismic zones, etc. Fully 
check the blueprints and consult with your local building officials. We 
recommend you work with a qualified builder when creating your home. The 
information in this document is believed accurate but is not warranted. 
AbbiSoft, Inc., shall not be liable in any way for this information.

This document helps people who are shopping for a home. You have 
permission to reproduce and distribute this 3 page document in whole or in 
part as long as you include the following phrase:

AbbiSoft's Home-Plan Finder(TM) has 2,300 house plans on CD-ROM, 65 
search criteria, 12 design firms. 
To order: call 800-345-HOME, FOR MORE TIPS GO TO: 
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Copyright (c) 1996 AbbiSoft, Inc.    All rights reserved



Your Worst Mistake
And How To Avoid It

John is a Realtor®.    He once had a customer who made a big mistake.

John was helping Susan find a home. He found a house that met all of her 
requirements. He felt sure she would like it. When they drove to the house, 
Susan looked out the car window and said "I don’t like this house. Let’s look 
at another one." John tried to persuade to her to look inside, but she refused.
They spent several months looking at houses, but Susan never found a 
home.

A few years later, Susan was invited to a dinner party. The party was at the 
house that she had refused to consider. When Susan walked inside, she felt 
immediately at home. As she walked through the house she thought "This 
house would have been my perfect home!"

You might find the right home and not realize it. This can happen if you don’t 
understand what to look for in a home. This guide helps home buyers avoid 8
common mistakes. You may want to share this with others.

How To Find The Right Home By Avoiding 
Common Mistakes
Mistake #1: Beauty Is Skin-Deep And Cosmetic Surgery Is Available
Some people will only look at a house if they like its appearance. 
Experienced designers know that a house’s exterior can easily be changed. 
In fact, the changes can be so dramatic that you won’t realize you are 
looking at the same house. To change the exterior, designers can use 
different windows, modify roof lines, and change exterior details. Shown 
below are two houses that have the same floor plan. As you can see they 
look nothing alike.



You can often customize a house’s exterior to suit your tastes. Don’t judge a 
home by its appearance. It’s the inside that really counts. After all, you’ll 
spend 90% of your time on the inside of your home.

Mistake #2:    People Think They Know What They Want
It’s important to be open-minded when looking at houses. By doing this, 
you’ll learn things you never realized. Over time, your ‘ideal’ home will 
evolve and change. If you are like most people, you will probably buy a home
that is different from what you thought you wanted. Don’t quickly discard 
houses. You will have a better understanding of what you want by taking a 
close look at many houses.

Mistake #3:    Overlooking Hidden Potential
You might discard the right home because you don’t see its hidden potential. 
For example, say you don’t like living rooms and you avoid houses that have 
living rooms. Did you know a living room could serve another purpose? It 
could become a den, a nursery, or an additional bedroom. It could also be an 
excellent dining room. Changing the location of a doorway or adding a wall 
may convert a room into something you would really love. Sometimes all you



need to do is rename a room. When looking at houses, look for the hidden 
potential.

Mistake #4:    Trying To Find The Perfect Home
 Some people spend years searching for the perfect home. However, they 
never find it because the perfect home is an imaginary dream found only in 
their mind. Their perfect home is a fantasy. It doesn't really exist.

It’s important to be realistic when shopping for a home. Ask yourself what 
are features you must have and what are features you want to have. When 
you find a house that meets your requirements, it may not have all of your 
wants. However, if you hold on to your dream of a perfect home you might 
pass up the right house and regret it later.

Mistake #5:    Misinterpreting Yourself
It’s important to understand the reasons for your preferences. By doing this 
you may discover things about yourself. For example, say you prefer older 
houses. Perhaps the reason you like older houses is because you like larger 
trees. If so, maybe you would like a newer house in a wooded area. In fact, 
maybe you would prefer a newer house because it needs less maintenance 
and is more energy efficient.

Mistake #6:    Champagne Tastes And A Beer Budget
Two of the main things that affect a house’s price are its size and features. 
Some people look for a large house with many features. Because of this, they
are unable to find a home they can afford.

It is possible to have a comfortable home with many features. Designers can 
make a house feel larger than it actually is. They accomplish this with 
efficient use of space, open floor plans, high ceilings, and good traffic flow. 
Effective window placement and sunlight can also make a house feel larger. 
It’s not the size of a house that matters. What’s more important is how 
comfortable your home feels. Perhaps you should consider houses that are 
smaller than what you think you want. By doing this you may find a 
comfortable home with the features you want.

If you build a house, you will probably make changes to the floor plan. 
Changes can increase the size of a house. If you start with a smaller plan, it 
is easier to make changes and stay within your budget. Because of this, you 
may want to consider plans that are smaller than what you think you want.

Mistake #7:    The Static House
Remember, a house can be changed. For example, say you find a house you 
like but wished it had a fireplace. You can often add a fireplace to a house.

If you are considering new construction, it’s even easier to modify a plan. For



example, perhaps you’ve decided that your home’s garage must face a 
certain direction. You can sometimes move the garage door to a different 
wall. By doing this, a house with a front garage can become a house with a 
side garage.

You can also change the size and location of rooms. For example, you can 
often increase or decrease the size of a garage. You can also reverse a plan 
to change the placement of its rooms. For example, say you found a plan 
with the garage on the left side and you want it on the right side. The plan’s 
mirror-reversal may suit your needs.

Mistake #8:    The Under-Utilized CD-ROM
AbbiSoft’s Home-Plan Finder(TM) is a powerful tool for quickly finding house 
plans. However, if you only search for what you think you want, then you 
might not discover what you really want. You will more likely find your home 
if you experiment with different searches. Try searching for houses using 
different square footage ranges. Search for different styles of homes. Search 
for different rooms or features. Search for plans from your favorite designers.
When searching, be flexible and set more of your criteria to be wants rather 
than musts. This way, your favorite houses are shown first, but you won’t 
rule out houses you may like.

Take advantage of the software’s features. For example, the reverse button 
shows you how a house looks if you reversed its plan. Read the descriptions 
for the houses. Bookmark your favorite plans. Magnify the pictures. Compare
various parts of a house using the multiple-picture view. Study your favorite 
houses by using 3 styles of print outs including: feature sheets, full-page 
pictures, and reversed pictures.

This guide helps people who are shopping for a home. It also helps 
people who sell homes.

You may want to give copies of this guide to your customers and business 
associates. You can print that document from this on-line help. However, if 
you have Microsoft® Word for Windows you’ll want to use the document 
found on the CD-ROM under      \document\WorstRea.doc You have 
permission to reproduce and distribute this document, as long as you do not 
change it and you include the following phrase:

 AbbiSoft's Home-Plan Finder(TM) has 2,300 house plans on CD-ROM, 65
powerful search criteria, 12 leading design firms.  To order call: 800-345-
HOME (800-345-4663). 
For more tips go to: http://www.abbisoft.com/
Distributor inquiries welcomed (call 309/662-0901) ©1996 AbbiSoft, Inc., PO Box 743, 
Bloomington, IL 61702, USA (Homes shown: plans 89595 & 89596, ©WD Farmer)
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Information About Blueprints
Blueprints are available for any of the homes on this CD-ROM. 

The pictures on this CD-ROM help you visualize the homes. To build a home, 
you will need the blueprints. The blueprints provide hundreds of additional 
details needed to build your home. You can save time and money buy 
purchasing these professionally designed blueprints. Best of all, you'll only 
pay a fraction of the original design cost because the design cost is shared 
by many people.

Quick Overview Of All Topics.

Construction Drawings Included With Most Blueprints:
Exterior Elevations
Wall Sections
Kitchen & Bath Cabinet Details
Detailed Floor Plans
Fireplace Details
Foundation Plan
Roof Plan
Cross Section
Schematic Electrical Layouts
Stair Details

Options & Extras:
Customizing A Plan
Reversed Plans
Materials List
Reproducible Masters
Home Building Details

Answers to Common Questions:
How Many Sets Of Plans Will You Need?
Shipping & Payment Information
Building Codes
Copyright Laws
Your Best Decision

Questions? Call our customer service number at    1-800-235-5700    (or 1-
860-343-5977).

FREE Gift With Your Order

To Order, call: 1-800-235-5700 or call: 1-860-343-5977



Or fill out an order-form in the Order tab of this software and fax your order 
to: 1-860-343-5984

Or mail order-form to: 
Garlinghouse
PO Box 1717
Middletown, CT 06457      USA
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You Earn $10 By Saving Others $10
If you know anyone who is shopping for a home, then please print 
this coupon and give it to them. Also, please give this coupon to 
Realtors®, builders, designers, and developers.

When you give this coupon to others, write your information in the "Referred 
by" section. We’ll send you a $10 check for each customer who uses your 
coupon to purchase a CD-ROM and $5 for customers who purchase our plan 
search service (see below). We have a 30-day money-back guarantee on our 
CD-ROM. You will receive a check when your referral keeps the software. Your
referral bonus will be sent 45 to 60 days after the shipping date of your 
referral’s order. Thanks for your help.
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How to Gain 3 to 6 New Customers Each Year
How To Sell Existing Houses: 

How many hours a year do you spend showing people homes they're not 
interested in?    If you saved that time, how many new customers could 
you help each year? Our software helps you quickly determine your 
customer's interests. By qualifying your customer, you can avoid showing 
them houses that won't interest them. Our CD-ROM contains 2,300 house 
plans and 65 powerful search criteria. By using our CD-ROM, your 
customers can quickly show you examples of homes they like.

Our software lets your customers prioritize their interests. Because of this,
their favorite homes will likely be the first homes they are shown. They 
can also put bookmarks on their favorite homes. You can save your 
customer's criteria and bookmarks. This information is a valuable 
reference when other homes come on the market. For example, you can 
compare those homes with your customer's criteria and view the homes 
they've bookmarked. This helps you determine if a house suits their 
interests.

How To Sell Land: 
Sometimes, a customer loves a certain lot, but can't visualize what type of
home could fit on the lot. You may close a sale by showing the customer 
homes that can be built on the land. You can easily find houses that will fit
on a lot by using our software to search on the lot's dimensions. Our 
software can also base searches on subdivision covenants (such as main 
floor square footage).

How To Sell New Construction:
You can't sell new construction unless you find a plan your customer likes.
Using our software, you can do a comprehensive search on 2,300 plans 
from 12 leading design firms. The 65 powerful search criteria will help you
quickly find a plan. Also, our software lets you prioritize the customer's 
needs.    By doing this, their favorite home will likely be one of the first 
homes you are shown. You can print feature sheets for homes and share 
them with your customers. Blueprints can be purchased for any of these 
homes.

How To Attract New Customers:
Our software has a spectacular feature called the " Tour of Homes Slide 
Show". This is a multi-media presentation uses animates special effects 
and music while showing various homes. This is a great way to attract 
attention at public events such as open houses and home shows.    
Sometimes the best way to gain a new customer is to show them your 
knowledge. Imagine how they'll feel when you find houses they like in a 



matter of minutes. Who knows, maybe you'll pick up a new construction 
sale while you're demonstrating the software.

How To Create Effective Marketing Literature:
Our software prints documents which can help your customers. For 
example, the document called Your Worst Mistake teaches your customers
how to shop for a home. That document overcomes common objections 
that interfere with sales. In addition, you can print feature sheets for any 
of the homes on the CD-ROM. These feature sheets may help you sell a 
home.

For specific details on using this software see Getting Down To Business

To order: call 800-345-HOME, FOR MORE TIPS GO TO: 
http://www.abbisoft.com/    ©1996 AbbiSoft, Inc.

AbbiSoft's Home-Plan Finder(TM) has 2,300 house plans on CD-ROM, 65 
search criteria, 12 design firms. 
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Congratulations!
You Found Your Dream Home!

You can already see it standing on your lot... you can see yourselves in your 
new home... enjoying family, entertaining guests, celebrating holidays.    All 
that remains ahead are the details.    That's where we can help.    Whether 
you plan to build-it-yourself, be your own contractor, or hand your plans over
to a builder, we can provide the blueprints needed to create your home.

We even make it simple for you to make modifications. Our professional 
designers can customize a plan for you. We can also provide a materials list 
for your home.

My grandfather started a tradition of quality when he founded the 
Garlinghouse company in 1907.    For almost 90 years, homeowners and 
builders have relied on us for accurate, complete, professional blueprints.    
Our blueprints help you get fast results and will save you money.    This 
software provides all the information you need to order your blueprints.

So get started now -- I know you are going to love your new home!

Sincerely,

Whitney Garlinghouse, 
President, Garlinghouse
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Getting Down To Business
Attracting New Customers
Selling Land
Selling Existing Houses
Prospecting Customers and Generating Sales
Selling New Construction
Creating Sales Presentations
Creating Marketing Literature
Marketing Architectural And Design Services
Marketing A Subdivision
Earn $10 By Saving Others $10

The topics (shown above) have information which may be useful for training 
purposes, trade publications, or newsletters. You have permission to 
reproduce and distribute those topics in whole or in part as long you include 
the following phrase:

AbbiSoft's Home-Plan Finder(TM) has 2,300 house plans on CD-ROM, 65 
search criteria, 12 design firms. 
To order: call 800-345-HOME, FOR MORE TIPS GO TO: 
http://www.abbisoft.com/    ©1996 AbbiSoft, Inc.
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Problems & Solutions
This section describes solutions to problems. Many of these problems rarely 
occur. We've mentioned these problems just in case you have them.

Click on a category related to your problem:

Installation Problems
Printer or Reports
Program Won’t Run
Music
Memory
Screen / Monitor
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How to Use This Software
This software is powerful. However, if you only search for what you think you 
want, then you might not discover what you really want. You will most likely 
find your home if you experiment with different searches. Try searching for 
homes that are larger or smaller than what you want. Look at different styles 
of homes. Look at all the plans from your favorite designers. Don't be afraid 
to play.

By experimenting with many searches, you will see more homes and you will 
learn more about what you want. This will also increase the chances of 
finding your dream home.

Before using this software, be sure you read the article called Your Worst 
Mistake. That article has important information that will help people who are 
looking for a home.

When using the software, you can get help on your current task by pressing 
the F1 key.

Click on these topics for more information:

Navigation
File
Search
View
Order
Help
How to order Blueprints
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Installation Problems
Couldn't install a file: You need to shut down all other programs before 
running the install. Other programs might be using files we need to update. 
Try shutting down all other programs and then re-install this software. If the 
error is because of the file 'THREED.VBX' and shutting down all programs and
rerunning install doesn't solve the error, then you'll need to do this:

Your computer has an older version of THREED.VBX that won't allow itself 
to be replaced while Windows is running. To correct this problem you will 
have to exit Windows and copy the THREED.VBX from our CD-ROM into 
your system directory. Here is how you do this:

Shut down Windows.

At the DOS prompt, type the following commands (Note for these 
instructions, we are using 'C:' for your hard drive and 'D:' for your CD-
ROM drive, if your drive letters are different then use the appropriate 
letters for the following instructions. Also, if your Windows System 
directory is not called 'WINDOWS\SYSTEM' then substitute your directory 
name in these instructions...

C:
RENAME    \WINDOWS\SYSTEM\THREED.VBX    THREED.OLD
COPY    D:\THREED.VBX    C:\WINDOWS\SYSTEM\THREED.VBX
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Music
Music sounds choppy - On some computers, the music in the Tour of 
Homes slide show may occasionally be interrupted. This occurs when there 
isn't enough resources available to handle the graphics and music. To reduce
or eliminate this problem you can:

Lower the resolution of your monitor. For example set your monitors 
resolution at 640 x 480, or at 600 x 800. The higher resolutions take more 
computing power and can interfere with the music. Also closing other 
programs may help. If you are using a laptop computer, try having the 
screen display go to a monitor instead of using the laptop's LCD display.

Copyright (c) 1996 AbbiSoft, Inc.    All rights reserved



Memory
Sometimes you may see an 'Out of Memory' error. This message is a warning
to tell you we weren't able to finish a task because your computer doesn't 
have enough memory to do that task. You can free up memory by shutting 
down other programs.
Copyright (c) 1996 AbbiSoft, Inc.    All rights reserved



Printer or Reports
Partial prints, unreadable prints, printer error messages: If you are 
using a laser printer, these problems probably occur because your printer 
doesn't have enough memory to print the page. You may be able to solve 
this problem, by reducing the resolution of your printer (to 300 dpi or 150 
dpi). (go into printer setup to change the dpi settings). If that doesn't solve 
the problem, try printing Full page pictures instead of Feature sheets ( Full 
page pictures need less printer memory). If your printer isn't a laser printer, 
then make sure the printer's ink cartridge or ribbon is working.

Delays in printing or slow printing: try going into Window's Printer setup 
and turn Print Manager off. This should speed up the printing. Also, lowering 
the resolution of your printer will help it print faster.

No prints: Be sure your printer is turned on, it's on-line, and has paper. Also,
sometimes a previous print error or problem can cause a printer to stop 
working. Try turning your printer off and then on again. If that doesn't work, 
try rebooting your system.

Plans not in proportion: We print the plans as large as possible in the 
space available on a page. We do this so that the plans are easier to read. 
However, because of this, the floor plans might not be in proportion to each 
other.
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Program Won't Run
Try rebooting your system.    If that doesn't solve the problem, please try re-
installing this software to fix this problem.
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Screen/Monitor
Colors look strange: Strange colors occur because your monitor doesn't 
have enough colors to correctly display the images (you probably have your 
monitor set at 256 colors). You can improve the colors by changing your 
monitor settings to use more colors (such as 32,000 colors). Also, 
redisplaying a picture (by clicking on the button that displays it) will often 
correct the colors.

Screens don't seem doesn't fit properly on the monitor: Some 
monitors or video cards may have difficulty displaying or resizing screens. Try
shutting down this program and re-running it. If that doesn't solve the 
problem, try changing your monitor's resolution and then rerun this program.

Screen locks up. If you change your monitors resolution while the 
application is running and the screen locks up, you can hit Ctrl + S to switch 
to another screen. In general, it is better to close programs before changing 
your monitor's resolution.

Screens are missing pieces, starting to break up or becoming 
chopping. You are probably running out of memory. Shut down other 
programs to free up memory. If this doesn't solve the problem try restarting 
the program, or reboot your system and then rerun this program. Also, if you 
are running Windows '95 and have the Task bar displayed, you may want to 
try closing or hiding the task bar. (The task bar causes the screen to get 
scrunched a little).

Plans not shown in proportion: We display plans as large as possible so 
that it is easier for you to read them. Because of this, the plans may not be 
in proportion to each other on your screen. If you want, you can adjust their 
proportion when using two-picture view. To do this, move the separator bar 
between the pictures to adjust their sizes.
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How To Order Blueprints
To Order blueprints for any of the homes on this CD-ROM call 

1-800-235-5700        or        1-860-343-5977

When calling, please have these items ready:

1) Credit Card Number
2) Plan Number
3) Order Code

To Order by fax, fill out an order-form (click on the Order tab of this software) 
and fax your order to:

1-860-343-5984

To order by mail, print an order-form (click on the Order tab of this software) 
and mail it to: 

Garlinghouse
PO Box 1717
Middletown, CT 06457      USA

For more information please read:

Information About Blueprints
Your Best Decision
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Help
The Help tab shows you documentation on how to use this software. The 
documentation also provides helpful information about shopping for a home. 

Hint: When using this software, you can get help on your current task by 
pressing the F1 key.
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This overview shows the information for all blueprint topics. When using this 
overview, you can see illustrations by clicking on the underlined words.

Construction Drawings included with most
Blueprints:

Exterior Elevations
Exact scale views of the front, rear and both sides of your home, showing 
exterior materials, details, and all necessary measurements.

Wall Sections
Detailed views of your exterior walls, as sliced through from top to bottom.    
These drawings clarify exterior wall construction insulation, flooring, and 
roofing details.    Depending on your specific geography and climate, your 
home will be built with either 2x4 or 2x6 exterior walls.    Most professional 
contractors can easily adapt plans for either requirement. 

Kitchen & Bath Cabinet Details
These plans show the specific details and placement of the cabinets in your 
kitchen and bathrooms as applicable.    Customizing these areas is simpler 
beginning with these details.    Kitchen and bath cabinet details are available 
for most plans. 

Detailed Floor Plans
Show the placement of all interior walls, the dimensions of rooms, doors, 
windows, stairways, and other details.

Fireplace Details
When your home includes one or more fireplaces, these detailed drawings 
will help your mason with their construction and appearance.    It is easy to 
review details with professionals when you have the plans for reference. 

Foundation Plan
With footings and all load-bearing points applicable to your home, including 
all necessary notation and dimensions.    The type of foundation supplied 
varies from home to home.    Local conditions and practices will determine 
whether a basement, crawlspace or a slab is best for you.    Your professional 
contractor can easily make the necessary adaptation.

Roof Plan
All information necessary to construct the roof for your home is included.    
Many blueprints contain framing plans showing all of the roof elements, so 
you'll know how these details look and fit together.



Cross Section
A detailed, full cross-sectional view through the entire house as if the house 
was cut from top to bottom.    This elevation helps a contractor understand 
the interconnections of the construction components.

Schematic Electrical Layouts
These drawings show the suggested locations for your switches, outlets and 
fixtures.

Stair Details
If stairs are part of the design you selected, specific plans are included for 
their construction.

Options & Extras
Reversed Plans
"That's our dream home... if only the garage were on the other side!". 

You could have exactly the home you want by flipping it end-for-end. Check it
out by simply using the reverse button in the View screen.

The Reverse button shows you how the blueprints will look if you order a 
"reversed" blueprint. We'll send you one full set of mirror-image plans (with 
the writing backwards) as a master guide for you and your builder. The 
remaining sets of your order will come as normally shown by this CD-ROM so 
the dimensions and specifications are easily read on the job site... and they 
will be specially stamped "REVERSED" so there is no construction confusion. 
We can only send reversed plans with multiple-set orders.

Some reversed plans have "Right reading" letters.    This means the picture is
reversed but the letters are not reversed. If the plan has a Right-reading 
reverse, the order screen will say "Right-reading" reverse. 

Customizing A Plan
You can often customize a plan to be just right for you. If fact, many plans 
have options and services to help you customize it.

Easy modifications to your dream home, such as minor non-structural 
changes and simple material substitutions, can be made between you and 
your builder and marked directly on your blueprints. However, if you are 
considering making major changes to your design, we strongly recommend 
that you purchase reproducible masters and use the services of a 
professional designer or architect. For additional information call the 
Garlinghouse at: 1-860-343-5977.



Many of the design firms offer a customization service and will customize 
their plans for you. This service is provided for an additional charge. In the 
specifications you will see the phrase "can be customized" if the design firm 
offers a customization service for the plan. For more information about 
customization service, please call the Garlinghouse at 1-860-343-5977.

Reproducible Masters
With reproducible masters (such as vellums), a professional designer can 
alter the drawings for you. Then you can use the masters to print copies of 
the modified plans as you need them. By starting with the completed 
detailed plans, the cost of professional design services may be significantly 
less.

Reproducible masters are only sold under the terms of a license agreement 
that you will receive with your order. Should you not agree to the terms, then
the masters may be returned unopened for a full refund.

To see if a home's plan is available in a reproducible master you can click on 
the Order Tab, and look at the Order Form. If a master is available, then the 
Order Form will have a 'Reproducible Master' price. Also, the Order Form tells
you what type of material is used for the master (such as vellum, mylar, etc.)

Materials List
It'll help you save money. Available at a modest additional charge, the 
Materials List gives the quantity, dimensions, and specifications for the major
materials needed to build your home. You will get faster, more accurate bids 
from your contractors and building suppliers — and avoid paying for unused 
materials and waste. Materials Lists are available for most home plans and 
can only be ordered with a set of home plans. 

Due to differences in regional requirements and homeowner or builder 
preferences... electrical, plumbing and heating/air conditioning equipment 
specifications are not designed specifically for each plan. However, non-plan 
specific home-building details can be purchased.

Home Building Details: 
Because local codes and requirements vary greatly, we recommend that you 
obtain drawings and bids from licensed contractors to do your mechanical 
plans. However, if you want to know more about techniques — and deal 
more confidently with subcontractors — we offer some remarkably useful 
detail sheets. These details sheets are excellent tools that will enhance your 
understanding of these technical subjects:

Construction Details
Eight sheets that cover the essentials of stick-built residential home 



construction. Details foundation options - poured concrete basement, 
concrete block, or monolithic concrete slab. Shows all aspects of floor, 
wall, and roof framing. Provides details for roof dormers, eaves, and 
skylights.    Conforms to requirements of Uniform Building code or BOCA 
code. Includes a quick index. only $14.95 per set

Plumbing Details
Nine sheets packed with information detailing pipe connection methods, 
fittings, and sizes. Shows sump-pump and water softener hookups, and 
septic system construction. Conforms to requirements of National 
Plumbing Code. Color coded with a glossary of terms and quick index. only 
$14.95 per set

Electrical Details
Nine sheets that cover all aspects of residential wiring, from simple switch 
wiring to the complexities of three-phase and service entrance connection.
Explains service load calculations and distribution panel wiring. Shows you 
how to create a floor plan wiring diagram. Conforms to requirements of 
National Electrical Code. Color coded with a glossary of terms and a quick 
index. only $14.95 per set

Answers to Common Questions:
Building Codes
All plans are drawn to conform to one or more of the industry's major 
national building standards in effect at the time they were drawn. However, 
due to the variety of local building regulations, your plan may need to be 
modified to comply with local requirements — snow loads, energy loads, 
seismic zones, etc. Do check them fully and consult your local building 
officials.

A few states require that all building plans used be drawn by an architect 
registered in that state. While having your plans reviewed and stamped by 
such an architect may be prudent, laws which require plans to be redrawn 
force you to pay unnecessary fees. If your state has such a law, we 
encourage you to contact your state representative and protest.

How Many Sets Of Plans Will You Need?
The Standard 8-Set Construction Package
Our experience shows that you'll speed every step of construction and avoid 
costly building errors by ordering enough sets to go around. Each 
tradesperson wants a set — the general contractor and all subcontractors; 
foundation, electrical, plumbing, heating/air conditioning, drywall, finish 
carpenters, and cabinet shop. Don't forget your lending institution, building 



department and, of course, a set for yourself.

The Minimum 5-Set Construction Package
If you're comfortable with arduous follow-up, this package can save you a 
few dollars by giving you the option of passing down plan sets as work 
progresses. You might have enough copies to go around if work goes exactly 
as scheduled and no plans are lost or damaged. But for only a few dollars 
more, the 8-set package eliminates these worries.

The Single-Set Decision-Maker Package
We offer this set so you can study the blueprints to plan your dream home in 
detail. But remember... one set is never enough to build your home... and 
they're copyrighted.

Copyright Laws
All of the plans on this CD-ROM are protected by copyright laws. You cannot 
build or modify these plans unless you purchase the construction drawings 
(such as blueprints or reproducible masters). When you purchase the 
drawings, you receive a license that lets you legally build or modify a plan. 

A plan's value comes from the hundreds of hours a skilled designer invests 
when creating it. This value is often called 'intellectual property'. When you 
purchase the drawings, these designers give you permission to use their 
intellectual property and benefit from the skills and work they invested to 
develop the plan. This permission is known as a 'license'.

Anyone who builds a home or modifies a plan without purchasing the 
drawings is in violation of copyright laws. Violating copyright laws is a serious
offense and can result in penalties of up to $100,000 per violation.

Professionally designed blueprints are very important because every aspect 
of your home, from the foundation to the roof, is influenced by blueprints. In 
fact, a professionally designed blueprint can quickly pay for itself. Please 
read: Your Best Decision for information on how these blueprints can help 
you.

"Borrowing Ideas" From A Plan:
Creating a plan (even a changed plan) from a copyrighted plan is illegal 
unless you have permission to do this. When you purchase the drawings, you
receive a license which lets you modify the plan.

Copying Blueprints That You Have Purchased:
If you purchase a reproducible master, then you will be able to make copies 
of the master. If you purchase blueprints, then you cannot make copies of 
the blueprints. Please purchase the number of blueprint sets you will need. 
Usually, most people need at least 8 sets of blueprints to build a home. Also, 



it usually costs less to buy extra sets at the time of your order, rather than 
buying them later.

Most design firms stamp their blueprints with colored seals. This is done to 
notify people the blueprints are copyrighted and that a non-colored seal 
indicates the blueprint has been illegally reproduced.

Building multiple homes from the same plan:
If you want to construct multiple homes from the same plan, you may need 
to buy a license for each home. This condition varies among the design 
firms. Check the plan's license for details, or call our customer service center
if you have a question about this.

Shipping & Payment Information:
Your order is processed immediately. Allow 10 working days from our receipt 
of your order for normal ground delivery. Save time with your credit card and 
our "800" number. Our delivery service must have a street address or Rural 
Route Box number — never a post office box. Use a work address if no one is 
home during the day.

Orders being shipped to Alaska, Hawaii, APO, FPO or Post Office Boxes must 
go via First Class Mail. Please include the proper postage.

Payment Information:
Only Certified bank checks and money orders are accepted and must be 
payable in US currency. For speed, we ship international orders Air Parcel 
Post. Please refer to the chart for the correct shipping cost.

FREE Gift With Your Order
Free Specifications And Contract Form provides the perfect way for you 
and your builder to agree on the exact materials to use in building and 
finishing your home before you start construction. This is a must for 
homeowner's peace of mind.
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Exterior Elevations
Exact scale views of the front, rear and both sides of your home, showing 
exterior materials, details, and all necessary measurements. 
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Wall Sections
Detailed views of your exterior walls, as sliced through from top to bottom.    
These drawings clarify exterior wall construction insulation, flooring, and 
roofing details.    Depending on your specific geography and climate, your 
home will be built with either 2x4 or 2x6 exterior walls.    Most professional 
contractors can easily adapt plans for either requirement.
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Kitchen & Bath Cabinet Details
These plans show the specific details and placement of the cabinets in your 
kitchen and bathrooms as applicable.    Customizing these areas is simpler 
beginning with these details.    Kitchen and bath cabinet details are available 
for most plans. 
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Detailed Floor Plans
Show the placement of all interior walls, the dimensions of rooms, doors, 
windows, stairways, and other details.
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Fireplace Details
When your home includes one or more fireplaces, these detailed drawings 
will help your mason with their construction and appearance.    It is easy to 
review details with professionals when you have the plans for reference. 

Copyright (c) 1996 AbbiSoft, Inc.    All rights reserved





Foundation Plan
With footings and all load-bearing points applicable to your home, including 
all necessary notation and dimensions.    The type of foundation supplied 
varies from home to home.    Local conditions and practices will determine 
whether a basement, crawlspace or a slab is best for you.    Your professional 
contractor can easily make the necessary adaptation.
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Roof Plan
All information necessary to construct the roof for your home is included.    
Many blueprints contain framing plans showing all of the roof elements, so 
you'll know how these details look and fit together.
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Cross Section
A detailed, full cross-sectional view through the entire house as if the house 
was cut from top to bottom.    This elevation helps a contractor understand 
the interconnections of the construction components.
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Schematic Electrical Layouts
These drawings show the suggested locations for your switches, outlets and 
fixtures.
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Stair Details
If stairs are part of the design you selected, specific plans are included for 
their construction.
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Reversed Plans Can Make Your Dream Home Just 
Right !
"That's our dream home... if only the garage were on the other side!". 

You could have exactly the home you want by flipping it end-for-end. Check it

out by simply using the reverse button in the View screen. 

The Reverse button shows you how the blueprints will look if you order a 
"reversed" blueprint. We'll send you one full set of mirror-image plans (with 
the writing backwards) as a master guide for you and your builder. The 
remaining sets of your order will come as normally shown by this CD-ROM so 
the dimensions and specifications are easily read on the job site... and they 
will be specially stamped "REVERSED" so there is no construction confusion. 
We can only send reversed plans with multiple-set orders.

Some reversed plans have "Right reading" letters. This means the picture is 
reversed but the letters are not reversed. If the plan has a Right-reading 
reverse, the order screen will say "Right-reading" reverse. 

Here's a picture of a reversed plan (to see the non-reversed picture, compare
this picture to the Exterior Elevations picture.)
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Customizing A Plan
You can often customize a plan to be just right for you. If fact, many plans 
have options and services to help you customize it.

Easy modifications to your dream home, such as minor non-structural 
changes and simple material substitutions, can be made between you and 
your builder and marked directly on your blueprints. However, if you are 
considering making major changes to your design, we strongly recommend 
that you purchase reproducible masters and use the services of a 
professional designer or architect. For additional information call the 
Garlinghouse at: 1-860-343-5977.

Many of the design firms offer a customization service and will customize 
their plans for you. This service is provided for an additional charge. In the 
specifications you will see the phrase "can be customized" if the design firm 
offers a customization service for the plan. For more information about 
customization service, please call the Garlinghouse at 1-860-343-5977.
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Reproducible Masters Make Modifications Easier
With reproducible masters (such as vellums), a professional designer can 
alter the drawings for you. Then you can use the masters to print copies of 
the modified plans as you need them. By starting with the completed 
detailed plans, the cost of professional design services may be significantly 
less.

Reproducible masters are only sold under the terms of a license agreement 
that you will receive with your order. Should you not agree to the terms, then
the masters may be returned unopened for a full refund.

To see if a home's plan is available in a reproducible master you can click on 
the Order Tab, and look at the Order Form. If a master is available, then the 
Order Form will have a 'Reproducible Master' price. Also, the Order Form tells
you what type of material is used for the master (such as vellum, mylar, etc.)
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Remember To Order Your Materials List
It'll help you save money. Available at a modest additional charge, the 
Materials List gives the quantity, dimensions, and specifications for the major
materials needed to build your home. You will get faster, more accurate bids 
from your contractors and building suppliers and avoid paying for unused 
materials and waste. Materials Lists are available for most home plans and 
can only be ordered with a set of home plans. 

Due to differences in regional requirements and homeowner or builder 
preferences... electrical, plumbing and heating/air conditioning equipment 
specifications are not designed specifically for each plan. However, non-plan 
specific home building details can be purchased including:

Construction Details
Plumbing Details
Electrical Details
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Home Building Details
Because local codes and requirements vary greatly, we recommend that you 
obtain drawings and bids from licensed contractors to do your mechanical 
plans. However, if you want to know more about techniques and deal more 
confidently with subcontractors we offer some remarkably useful detail 
sheets. These details sheets are excellent tools that will enhance your 
understanding of these technical subjects:

Construction Details
Plumbing Details
Electrical Details
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Construction Details
Eight sheets that cover the essentials of stick-built residential home 
construction. Details foundation options - poured concrete basement, 
concrete block, or monolithic concrete slab. Shows all aspects of floor, wall, 
and roof framing. Provides details for roof dormers, eaves, and skylights. 
Conforms to requirements of Uniform Building code or BOCA code. Includes a
quick index. only $14.95 per set
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Plumbing Details
Nine sheets packed with information detailing pipe connection methods, 
fittings, and sizes. Shows sump-pump and water softener hookups, and 
septic system construction. Conforms to requirements of National Plumbing 
Code. Color coded with a glossary of terms and quick index. only $14.95 per 
set
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Electrical Details
Nine sheets that cover all aspects of residential wiring, from simple switch 
wiring to the complexities of three-phase and service entrance connection. 
Explains service load calculations and distribution panel wiring. Shows you 
how to create a floor plan wiring diagram. Conforms to requirements of 
National Electrical Code. Color coded with a glossary of terms and a quick 
index. only $14.95 per set
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An important note:
All plans are drawn to conform to one or more of the industry's major 
national building standards in effect at the time they were drawn. However, 
due to the variety of local building regulations, your plan may need to be 
modified to comply with local requirements — snow loads, energy loads, 
seismic zones, etc. Do check them fully and consult your local building 
officials.

A few states require that all building plans used be drawn by an architect 
registered in that state. While having your plans reviewed and stamped by 
such an architect may be prudent, laws which require plans to be redrawn 
force you to pay unnecessary fees. If your state has such a law, we 
encourage you to contact your state representative and protest.
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How Many Sets Of Plans Will You Need?
The Standard 8-Set Construction Package
Our experience shows that you'll speed every step of construction and avoid 
costly building errors by ordering enough sets to go around. Each 
tradesperson wants a set — the general contractor and all subcontractors; 
foundation, electrical, plumbing, heating/air conditioning, drywall, finish 
carpenters, and cabinet shop. Don't forget your lending institution, building 
department and, of course, a set for yourself.

The Minimum 5-Set Construction Package
If you're comfortable with arduous follow-up, this package can save you a 
few dollars by giving you the option of passing down plan sets as work 
progresses. You might have enough copies to go around if work goes exactly 
as scheduled and no plans are lost or damaged. But for only a few dollars 
more, the 8-set package eliminates these worries.

The Single-Set Decision-Maker Package
We offer this set so you can study the blueprints to plan your dream home in 
detail. But remember... one set is never enough to build your home... and 
they're copyrighted.
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Blueprints And Plans Are Protected By Copyright 
Laws
All of the plans on this CD-ROM are protected by copyright laws. You cannot 
build or modify these plans unless you purchase the construction drawings 
(such as blueprints or reproducible masters). When you purchase the 
drawings, you receive a license that lets you legally build or modify a plan. 

A plan's value comes from the hundreds of hours a skilled designer invests 
when creating it. This value is often called 'intellectual property'. When you 
purchase the drawings, these designers give you permission to use their 
intellectual property and benefit from the skills and work they invested to 
develop the plan. This permission is known as a 'license'.

Anyone who builds a home or modifies a plan without purchasing the 
drawings is in violation of copyright laws. Violating copyright laws is a serious
offense and can result in penalties of up to $100,000 per violation.

Professionally designed blueprints are very important because every aspect 
of your home, from the foundation to the roof, is influenced by blueprints. In 
fact, a professionally designed blueprint can quickly pay for itself. Please 
read: Your Best Decision for information on how these blueprints can help 
you.

"Borrowing Ideas" From A Plan:
Creating a plan (even a changed plan) from a copyrighted plan is illegal 
unless you have permission to do this. When you purchase the drawings, you
receive a license which lets you modify the plan.

Copying Blueprints That You Have Purchased:
If you purchase a reproducible master, then you will be able to make copies 
of the master. If you purchase blueprints, then you cannot make copies of 
the blueprints. Please purchase the number of blueprint sets you will need. 
Usually, most people need at least 8 sets of blueprints to build a home. Also, 
it usually costs less to buy extra sets at the time of your order, rather than 
buying them later.

Most design firms stamp their blueprints with colored seals. This is done to 
notify people the blueprints are copyrighted and that a non-colored seal 
indicates the blueprint has been illegally reproduced.

Building multiple homes from the same plan:
If you want to construct multiple homes from the same plan, you may need 
to buy a license for each home. This condition varies among the design 
firms. Check the plan's license for details, or call our customer service center



if you have a question about this.
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Shipping & Payment Information
Your order is processed immediately. Allow 10 working days from our receipt 
of your order for normal ground delivery. Save time with your credit card and 
our "800" number. Our delivery service must have a street address or Rural 
Route Box number - never a post office box. Use a work address if no one is 
home during the day.

Payment Information
Only Certified bank checks and money orders are accepted and must be 
payable in US currency. For speed, we ship international orders Air Parcel 
Post. Please refer to the chart for the correct shipping cost.
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FREE Gift With Your Order
Free Specifications And Contract Form provides the perfect way for you 
and your builder to agree on the exact materials to use in building and 
finishing your home before you start construction. This is a must for 
homeowner's peace of mind.
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Attracting New Customers
The "Tour of Homes slide show" is an excellent way to attract attention at 
public events such as trade shows, parade of homes, home shows, or other 
public events. The music and special effects will attract people's attention 
and draw them into your booth. To use this feature, click on Tour of Homes 
button in the View screen.



Motivating Potential Customers To Contact You
For information on how to generate sales leads and encourage contacts from 
new customers, read the article called: Prospecting Customers And 
Generating Sales.



Promotional Assistance
AbbiSoft, Inc would like to help you promote your business. Sometimes, we'll 
provide a free CD-ROM to be used in a drawing at public events. This 
encourages more traffic to your booth and you'll benefit by having a record 
of the potential customers who attended your booth. To see if your event 
qualifies for this offer, please do the following:

Write a letter to AbbiSoft, Inc with this information:

 Description of the event
 Date of event
 Approximate number of people attending event

Your letter or business letterhead should also have this information about 
your business:

 Person to contact & their title
 Business name
 Phone number
 Mailing address
 Fax number
 Email address (if you have one). 

Send your letter to:

ATTN: PUBLIC EVENT PROMOTIONS
ABBISOFT, INC
PO BOX 743
BLOOMINGTON, IL 61702-0743    USA

Or fax your letter to: 309/663-2601

You'll notice our software license grants you the " Right of public display and 
public performance". This gives you permission to use our software at public 
events. We believe our software will be a valuable tool for promoting your 
businesses.
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Selling Land
Sometimes you may have a customer who loves a certain lot, but they are 
afraid to buy the lot because they can't visualize what type of home would fit
on the land. Imagine how your customer would feel if you showed them 
wonderful homes that are perfect for the lot. You can use this software to find
homes that will fit on a lot. Here's how to do this:

1) Click on the Search tab
2) Click on the Other tab 
3) Click on the Maximize Criteria button
4) Click on the Criteria tab
5) Enter the Width & Depth criteria for the land. Remember to subtract the 

setbacks and easements, when entering the land's buildable area.
6) Click on the View Tab
7) Click on the printer button



8) In the Printer window, select "Print All Matching" The printouts generated 
will show homes that will fit on the land
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Prospecting Customers and Generating Sales
Finding a new customer can take a great deal of work. Wouldn't it be nice if 
new customers would just call you on the phone and ask for an appointment?
This could happen if you use creative marketing techniques. Here is a story 
about a creative marketing campaign:

John is a builder and he needed more customers. In the past, John had 
tried promoting his business. However, he didn't have much success.    
Then one day, John had an idea. He was so excited that he announced his 
idea by sending out press releases. He sent press releases to the local 
paper, radio station, and television station. Here is a copy of his press 
release:

Press Release For more information contact:

For Immediate Release John Smith, President
September 27, 1996 Smith Construction Company,

phone: 309/555-1234

Find Your Dream Home In 3 Minutes
Back in the olden days (about 2 years ago), finding the perfect home was 
time-consuming. 

Fortunately, new technology can help people find their dream home.    
Smith Construction 

Company is providing a free service to help people find the perfect home 
plan. They will 

help you use a powerful computer program known as 'AbbiSoft's Home-
Plan Finder(TM)'. 

This CD-ROM contains 2,300 house plans from 12 leading design firms. 
Finding a home is 

easy because you can choose from 65 criteria to find homes you would 
like. The software 

quickly searches through 2,300 house plans and finds all the homes which 
suit your needs. 

You can even prioritize your criteria and the software sorts the plans based
on your 



priorities. Because of this, your favorite home will likely be one of the first 
homes you see. 

After doing a search, you can view the homes on the computer screen, and
print feature 

sheets to take with you.

There is no cost or obligation for using this service and it only takes a few 
minutes. 

According to John Smith, company president "We enjoy helping others.    
It's really fun 

seeing the reactions of the people we help. Some people have spent 
months looking through 

house plan books and when they use our service they are astonished. 
Within a few minutes 

we can usually find a home they like. The service can also help people who
have already 

decided on a plan because a plan search can help people be more 
confident about their 

decision". To schedule your free plan-search appointment, call Smith 
Construction at: 

309/555-1234.
 ###

John was surprised by the response his press release generated. Within a 
week he had 23 potential customers schedule appointments for a plan-
search. When people came to his office, John showed them how to use the 
software and answered their questions. While looking at their favorite 
homes, John offered ideas to help people when building a home. He shared
his knowledge with the client, but was careful he wouldn't make them feel 
like they were receiving a sales pitch.

When people were finished searching, John saved their search criteria and 
bookmarks in a computer file. He explained the file would help him in case 
they had any questions about the homes they had found. He also told 
them he would be receiving new versions of the software with hundreds of 



new plans. He said he would be happy to call them and let them know 
when new versions of the software came in.

Some people found plans they liked and John printed them on the backs of 
paper which had his business letterhead. As people left he told them to call
if they had any questions about building homes and suggested they tell 
others about his plan search service. He also handed them a folder which 
contained useful information about building homes. One of the documents 
in his folder was a document called "Your Worst Mistake". That document 
provided useful information on how to shop for a home plan.

AbbiSoft, Inc has tested a press release that is similar to the one shown 
above and had a very good response. You may want try this press release to 
promote your business. Best of all, it will only cost you the price of a few 
postage stamps to try this. You will have the best response if you are one of 
the first businesses to use this press release in your city. Send out your 
press releases today. You have permission to use and modify our press 
release as long as you do not charge people for using our software.

You also have permission to use the artwork found in the AbbiArt directory 
of this CD-ROM for the purpose of creating press releases, brochures, 
advertisements or other literature to inform people of your plan search 
service.
 
There are 2 ways you can copy the press release into your word processor. If 
you have Microsoft® Word for Windows then you can use the file found on 
the CD-ROM in:    \document\PressRel.doc. Otherwise, you can copy the 
press release from this help file and paste it into your word processor. To do 
this, click on the Edit menu shown at the top of this help window and then 
select Copy. Then highlight the press release and click the copy button. Then 
go to your word process and paste the text into a document. You may want 
to send your press-release to newspapers, television stations, and radio 
stations. The more places which carry your press release, the better the 
response will be.

John used several creative marketing techniques. First, he attracted interest 
to his business by creating a newsworthy story. Research has shown that a 
news story can be up to 12 times more effective than an advertisement. 
People buy newspapers to read news. They are more likely to read 
information that is newsworthy. John presented his story in a way to make it 
interesting by using humor, stories, and specific facts. This increased the 
chances the media will use his story. It also increases the chance that people 
will read his story. He was also careful to make his story "news" and avoided 
things that would make the story look like an advertisement.

In the press release, John used several key words to increase his response -- 



you'll notice his service is "free" and there is "no obligation". Sometimes the 
fastest way to kill a sale is to make a customer feel like they are receiving a 
sales pitch. Nothing about John's press release or his interactions with the 
prospects made them feel this way. Instead, John gains their confidence by 
providing them with useful information.

John has done several other things. He has gotten people to visit his office 
and meet with him. Some of these people might not be looking for a home 
right now, however they will likely know other people who are and by 
meeting John they may recommend him to others.

John is also collecting information about his prospects. As they use the 
software, he learns about their interests and saves the results of what he has
learned in a computer file. Plus, as new versions of the software become 
available, he can contact the prospect to arrange future meetings. Over time
these prospects will get to know John and benefit from the knowledge he 
shares with them. This also increases the chance that those prospects will 
become customers.

You may want to subscribe to this CD-ROM. Approximately every 6-months 
we will come out with a new version which will have hundreds of new plans. 
Also, you'll save money by becoming a subscriber. For more information, 
please read: Special Offers on Future Releases
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Creating Sales Presentations
AbbiSoft's Home-Plan Finder(TM) provides many features for creating 
effective sales presentations. 

Here is information on the presentations available and how to use them. 
Also, details are provided for creating presentation, saving presentations, 
and electronically distributing a presentation.

Creating Multi-Media Presentations With Music And Animated 
Special-Effects
You can create multi-media presentations to attract attention at public 
events such as home shows or trade shows. For details read the article: 
Attracting New Customers

Improving Your Sales By Using Effective Marketing Literature
You may want to print the following documents and share them with your 
customers:

Your Worst Mistake (This document explains what to look for when 
shopping for a home and it overcomes common objections that interfere 
with sales).You can print that document from this on-line help. However, 
if you have Microsoft® Word for Windows you'll want to use the 
document found on the CD-ROM under      \document\WorstRea.doc

Your Best Decision (This document provides helpful information about 
building a home)

Creating Feature Sheets
You can create feature sheets for any of the homes on this CD-ROM. These 
feature sheets may help you convince a customer to build the home. Also, if 
you build a spec home for one of the homes you found on this CD-ROM, then 
the feature sheet may help you market the home. To create a feature sheet, 
click on the View tab and then click on the printer button.



Creating Interactive Sales Presentations
In a matter of minutes you can create a presentation that is customized to 
the interests of your customer. To do this, you simply search for homes based
on their criteria and save the results in a file. When you meet with your 
customer, open your file and show them all the homes you found. Your 



presentation could use the Tour of Homes slide Show to have the computer 
show homes to your customer. Or your presentation could be a "hands-on" 
presentation where your customer uses the software to view plans, magnify 
plans, reverse plans, and view various parts of the homes. Your customer can
even bookmark their favorite homes and do their own searches.

We recommend the "hands-on" approach because it helps you learn more 
about your customer's needs. This also saves you time because you can let 
your customers create their own presentations. You can even save your 
customer's searches and bookmarks for future reference. These 
presentations are useful for many situations:

If you are a builder you can bookmark the types of homes you like to build 
and then show them to your customers.

If you are selling land in a subdivision, you can bookmark the types of 
homes that are be suitable for the subdivision and it's convenants. Also, if 
you have some narrow lots, you may want to create a file showing homes 
that will fit on specific lots and show them to customers who like the lots. 
For details on doing this, read the article called: Selling Land.

When selling homes, you need to show homes to your customers to 
determine their interests. You could learn their preferences by driving them
around to many homes. However, you can save time by using your 
computer to show your customers examples of homes and qualify their 
interest before driving them to see homes. Also, you can save a file on 
your customer's searches and bookmarks. Later you can review this 
information and compare it to other homes that come on the market. This 
makes it easy to determine if a home might interest your customer.

How To Create And Save Presentations
To create a presentation, first you will do a search to find homes. You can 
also bookmark your favorite homes. Then when showing your presentation 
you can show homes that met the search criteria or just show homes you've 
bookmarked. Here's how to do this:

Step 1:
1) Click on the Search tab
2) Enter the search criteria
3) After the search criteria is entered, click on the View tab to view the 

homes 
4) You can put bookmarks on homes by clicking on the Bookmark button:



5) When you are finished, save your criteria/bookmarks. To do this, click on 
File tab and enter the name of your presentation in the first field. Then click 
on the Save button.

Step 2:    Now you have saved your presentation. Later you can open your 
presentation and view the bookmarked homes and search criteria. Here's



how to open a presentation:

1) Click on the File tab
2) In the first field, choose the name of the presentation you want to 

open.
3) Click on the Open button
4) Now the software's search criteria is set to the search criteria you had 

saved and the bookmarks are put on the homes you had bookmarked. 
To view or change the criteria, click on the Search tab. The search 
screen will show the criteria that you saved in your presentation.

5) To view the homes you had bookmarked: click on the View Tab, Then 
click on the View Bookmarks button:



6) Now, all the homes shown are the homes you bookmarked.

Hint: The bookmarks stay on homes when you change your search criteria.
You may want to try many searches and save your bookmarks when you 
are done searching. This will help you find more homes to bookmark.



How To Distribute And Share Your Presentation
You can distribute your presentation on a floppy disk or send your 
presentation using email. This makes it easy to put your presentation on 
another computer or share it with somebody else. To use these files, the 
destination computer needs to have a copy of AbbiSoft's Home-Plan 
Finder(TM) CD-ROM and the CD-ROM should be the same version as your CD-
ROM. Here's how to share a presentation:

When you save your bookmarks and criteria (in the File tab screen), two 
files are created in the AbbiSoft directory. Those files have file extensions 
of 'bmk' and 'cri' and those files contain your presentation and need to be 
copied to the computer you want to run your presentation on.

For example, say you create a presentation on your desktop computer for 
a customer named Mr. Smith. Then you want to show him your 
presentation on your laptop computer. You saved his presentation using 
the name 'SMITH'. To copy his presentation to your laptop computer, you 
first copy his files from the AbbiSoft directory (on your desktop computer) 
onto a floppy disk. These are the files you would copy for the Smith 
presentation:

smith.bmk
smith.cri

Then you copy those files from your floppy disk and into the AbbiSoft 
directory on your laptop. When you run the CD-ROM on your laptop, click 
on the File tab and then open the Smith file.

You may want to subscribe to this CD-ROM. Approximately every 6-months 
we will come out with a new version which will have hundreds of new plans. 
Also, you'll save money by becoming a subscriber. For more information, 
please read: Special Offers on Future Releases
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Special Offers on Future Releases
Approximatly every 6 months, we will be shipping a new version of our CD-
ROM with new plans and features. If you are on our mailing list, you will 
receive discounts and special offers for future releases of our CD-ROM. To be 
put on our mailing list, please send your name and mailing address to us. 
Here is how to contact us:

Email:

abbisoft@aol.com
please put ‘Special Offers’ in the subject of your email

Or mail your information to:

Attn: Special Offers
AbbiSoft, Inc
PO Box 743
Bloomington, IL 61702    USA
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Selling Existing Houses
It takes time to learn what a customer is looking for in a home. To do this, 
some real-estate professions spend many hours driving customers around to 
look at homes. However, there is a faster and easier way to learn about your 
customer's interests.

You can use this software to quickly qualify your customer's needs. Also you 
can save information you've learned about your customer so that you can 
refer to this information later. Here is how to you can use this software to sell
homes:

Step 1: First you may want to help you customers understand how to shop 
for a home. This can simply your sales process. Feel free to print these 
documents and share them with your customers:

Your Worst Mistake (This document explains what to look for when 
shopping for a home and it overcomes common objections that 
interfere with sales).You can print that document from this on-line help.
However, if you have Microsoft® Word for Windows you'll want to use 
the document found on the CD-ROM under      \document\
WorstRea.doc

Your Best Decision (This document provides helpful information about 
building a home)

Step 2: Next, you create a preference file for your customer. To do this:

1) Click on the Search tab
2) Have the customer enter their search criteria
3) After they enter their criteria, Click on the View tab to see the homes 

that were found
4) Whenever the customer sees a home they like, have them put a 

bookmark on the home. You do this by clicking on the Bookmark 
button:



5) After they are finished viewing the homes, save their criteria and 
bookmarks in a file. To do this, click on File tab and type their last name in 
the first field. Then click on the Save button.

6) You may also want to have them experiment with additional searches. 
This may help your customer see other possibilities and learn things 
about what they really want in a home.



Step 3: When new houses come on the market, you may want to review 
your customer's preferences to see how they compare with the homes 
that are available. The file you saved (in step 2) keeps track of the homes
your customer bookmarked. Here is how to use files you save for a 
customer:

1) Click on the File tab
2) In the first field, choose the name of the customer's file
3) Click on the Open button
4) Now the software's search criteria is set to your customer's 

preferences. To view their criteria, click on the Search tab. The search 
screen will show the criteria that your customer had entered

5) To view the homes your customer had bookmarked: click on the View 
Tab, Then click on the View Bookmarks button:



6) Now, all the homes shown are the homes your customer had 
bookmarked. Compare these homes to the homes that are for sale. 
This makes it easy to see if a home might interest your customer.

As an added benefit, you may sell a new construction to a customer who 
finds a plan they liked. Complete blueprints can be purchase for any of the 



homes on this CD-ROM and within a few days your customer can start 
building their home. For more information about blueprints, please read: Your
Best Decision

You may want to subscribe to this CD-ROM. Approximately every 6-months 
we will come out with a new version which will have hundreds of new plans. 
Also, you'll save money by becoming a subscriber. For more information, 
please read: Special Offers on Future Releases
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Selling New Construction
To use this CD-ROM for selling new construction, have your customers use 
the software to search for home plans. Also, you can simplify your marketing 
effort by helping the customer understand how to shop for a home. You may 
want to print these articles and give them to your customers:

Your Worst Mistake (This document explains what to look for when 
shopping for a home and it overcomes common objections that interfere 
with sales).You can print that document from this on-line help. However, 
if you have Microsoft® Word for Windows then you'll want to print the 
document found on the CD-ROM in:    \document\WorstBui.doc

Your Best Decision (This document provides helpful information about 
building a home)

If your customer doesn't find a home, you may still be able to generate a 
future sale. To do this, you'll need to save their criteria and bookmarks. Then 
when you get your next version of this CD-ROM youcan redo their search on 
a CD-ROM containing additional plans. For details on doing this read the 
article called: Prospecting Customers and Making Sales.

You may want to subscribe to this CD-ROM. Approximately every 6-months 
we will come out with a new version which will have hundreds of new plans. 
Also, you'll save money by becoming a subscriber. For more information, 
please read: Special Offers on Future Releases
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Marketing A Subdivision
If you are selling land in a subdivision, you may want to have plans showing 
customers of the types of homes suitable for your subdivision. You can 
provide these examples by printing feature sheets or you can show a sales 
presentation on your computer..

To create feature sheets, click on the print button in the View screen.



For creating and showing presentations on your computer, read the article 
Creating Sales Presentations.

This software can also help you sell land. For details, read the section called 
Selling Land



For creating multi-media presentations to attract attention at public events 
such as home shows or open houses, read the article: Attracting New 
Customers
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Creating Marketing Literature
Improve Your Sales By Using Effective Marketing Literature
You may want to print the following documents and share them with your 
customers:

Your Worst Mistake (This document explains what to look for when 
shopping for a home and it overcomes common objections that interfere 
with sales).You can print that document from this on-line help. However, 
if you have Microsoft® Word for Windows then you'll want to print the 
document found on the CD-ROM in:    \document\WorstRea.doc

Your Best Decision (This document provides helpful information about 
building a home)

Creating Feature Sheets
You can create feature sheets for any of the homes on this CD-ROM. These 
feature sheets may help you convince a customer to build the home. Also, if 
you build a spec home for one of the homes you found on this CD-ROM, then 
the feature sheet may help you market the home. To create a feature sheet, 
click on the View tab and then click on the printer button.
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Marketing Architectural And Design Services
One of the first steps of marketing your services is to help the customer 
understand the value of your services. You may want to print a copy of the 
article called Your Best Decision and give it to new customers. That 
document explains the importance of professionally designed blueprints.

When designing a home for someone, one of the first steps is to find out 
their needs and interests. Our CD-ROM can help you quickly determine your 
client's interests.

Sometimes, you may have a customer who wants a professionally designed 
home, but cannot afford the design services they need. For these customers,
you may want to suggest they buy an existing plan and hire you to modify 
the plan. Reproducible masters (such as vellums) can be ordered for many of
the homes on this CD-ROM. Then you can customize the masters to suit your
clients needs. Because you have started with an existing plan, you may be 
able to create a 'custom' home for someone who normally could not afford 
design services. One of the best ways to gain new business is referrals from 
satisfied customers. By starting with reproducible masters you may be able 
to help more customers and gain more future business from referrals.

You may want to subscribe to this CD-ROM. Approximately every 6-months 
we will come out with a new version which will have hundreds of new plans. 
Also, you'll save money by becoming a subscriber. For more information, 
please read: Special Offers on Future Releases
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About...

Copyright 1996, AbbiSoft, Inc., All rights reserved
House plans copyrighted by the following companies or their licensors, all 
rights reserved:

Design Basics, Inc.
Garlinghouse
Home Planners, Inc.
WD Farmer
Piercy & Barclay Designers, Inc.
Carmichael & Dame
National Plan Service USA, Inc. 
L.M. Bruinier & Associates
Select Home Designs
Norris Plans Co.
Archway Press, Inc.
SunRidge Design.

Music, Copyright Michael Hogan, All rights reserved.

Portions of the imaging technology of this product are Copyrighted by 
AccuSoft Corporation.
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AbbiSoft, Inc.

Contacting AbbiSoft:

AbbiSoft Inc.
PO Box 743
Bloomington, IL 61702

Email: abbisoft@aol.com
Internet: http://www.abbisoft.com/
Technical support: 309/662-4492
Corporate Office: 309/662-0901 
Software sales: 800-345-HOME
Fax: 309/663-2601



Active window
Is the last picture window you clicked inside of. The active window is where pictures will be 
displayed when you change pictures in a split view window.



Bookmark
Bookmarks can be put on homes you like. Bookmarks help you find or print homes you like. 
In the View screen you bookmark a home by clicking on the bookmark button.

You can unbookmark a home by clicking on the unbookmark button.



You can view your bookmarked homes by clicking the view bookmarks button.



Also, when you print plans, you can select an option to print all of your bookmarked plans.



Covenant
Rules that specify requirements of homes built in a subdivision. Covenants protect the value 
of existing homes and influence the type of homes that are built in a neighborhood.



Customize
Customized plans are available for many of the homes on this CD-ROM. Many of the design 
firms will customize their plans to suit your needs (for an additional fee). If the designer 
offers a customization service for a plan, then the home’s specifications will say "This plan 
can be customized." You can also buy reproducible masters and have your own designer or 
builder customize a plan. For details on customization, call our Plan Ordering Service.



Easements
Portions of land reserved for utilities (such as gas, electric, sewer) or for other purposes such
as roads. When determining the buildable area of your land, remember to subtract the 
easements.



Feature sheets
Have several pictures printed on one page. Feature sheets also have additional information 
such as feature summaries, and specifications. 

Note: We print the plans as large as possible in the space available. Because of this, the floor
plans might not be in proportion to each other.



Finished
Refers to floor space that is livable area. Usually, finished areas have floor coverings (such 
as carpet, wood, linoleum, tile). A garage or unfinished basement is not considered finished 
square footage.



Full page pictures
Are reports where each page has one picture, and the picture is enlarged to take up the 
whole page. Full page pictures make it easy to see the details in a plan. 

Note: We print the plans as large as possible in the space available. Because of this, the floor
plans might not be in proportion to each other.



Laundry room
Is the area where the washer and dryer is kept. Laundry areas are small and plans can often 
be customized to change the location of the laundry room. If a laundry area isn’t shown on a
plan and the home has a basement, then this software assumes the lower floor will be the 
location of the laundry room. Also, some homes (such as vacation homes) might not have 
laundry areas.



Master bedroom
These bedrooms usually have attached full baths and are larger than the other bedrooms of 
a home.



Maximize criteria
Button is used to quickly find all homes. This is helpful if you want to find all homes that 
have a particular feature. For example, let’s say you want to see all Victorian homes. To do 
this, you would click the Maximize Criteria button and then go to the Architecture Tab and 
search for Victorian homes. The Maximize Criteria button is found in the Other tab.



Multi-level
Have floors at varying levels. Common names for multi-level homes include: quad-level, tri-
level, bi-level, split foyer, split-level.



Musts
When you make an item a 'Must' then only homes that have the item are found. If an item 
isn’t required but is something you would like to have, then make it a 'want'. Remember, 
many home plans can be customized. In general, it's better to search for wants instead of 
Musts because Musts might eliminate homes you would like.



Plan Ordering Service
To order plans, or for questions about plans, call: 

800-235-5700 or    860-343-5977      
or fax inquires to: 860-343-5984

Or write to:

Garlinghouse
PO Box 1717
Middleton, CT 06457



Potential bedrooms
Rooms or areas that could easily be converted into bedrooms (such as den, lofts, bonus 
rooms, and sometimes formal living areas). Also, some homes might have alternate plans 
that would offer additional bedrooms. When a home has the potential for other bedrooms, 
the home's specifications will show a range of bedrooms. For example: "3 - 4" means the 
home has at least 3 bedrooms and a potential for 4 bedrooms.



Printer problems & solutions
Partial prints, unreadable prints, printer error messages: If you are using a Laser printer, 
your printer likely doesn’t have enough memory to print the page. You may be able to solve 
this by reducing the resolution of your printer (to 300 dpi or 150 dpi). If that doesn’t solve 
the problem, try printing Full page pictures instead of feature sheets. If your printer isn’t a 
laser printer, then make sure the printer’s ink cartridge or ribbon is working.

Delays in printing: try going into Windows Printer setup and be sure print manager is turned 
off. This should speed up the printing.

No prints: Be sure your printer is turned on, it is on-line, and has paper. 



Promote your business
The "Tour of Homes" slide show is an excellent way to attract attention to your business at 
trade shows, parade of homes, home shows, or other events. The music and special effects 
will attract peoples attention and draw them into your booth. Also, we'd like to help you. 
Sometimes we’ll provide a free CD-ROM to raffle off at your event. This would encourage 
even more traffic to your booth and you'll benefit by having a record of the potential 
customers who attended your booth. For more information, read the article Attracting New 
Customers found in the Getting Down to Business section of this Help.



Reproducible masters
Are home plans that can be reproduced. Also, masters can be modified to customize the 
plan and the be used to create blue prints. Masters are typically printed on clear, more 
durable materials (such as vellum or mylar). To see if reproducible masters are available for 
a home, click on the Order tab.



Restore default criteria
Button resets all criteria to the normal starting values. This button is helpful for resetting 
criteria after you've done a Maximize Criteria search.



Reverse
Plans are available for homes if you want to build a plan in mirror image.



Right of public display
For copyrighted materials, a person or organization needs written consent to publicly display
copyrighted materials (such as pictures) or publicly perform copyrighted materials (such as 
music). Our software license has granted this written consent to our customers. Because of 
this, our customers can publicly show and use AbbiSoft's Home-Plan Finder(TM). This lets our
customers use our software for trade shows, open houses, home shows, seminars, kiosks, 
educational purposes, television broadcasts, training videos, newsletters, trade publications,
and other public uses that may help our customers (please refer to the software's license 
agreement for details). We believe our software will be a valuable tool for promoting 
businesses.



Setbacks
Minimum distances a home must be built from the edges of its property. Often, building 
codes have rules specifying setbacks from the street or setbacks from neighboring property. 
Remember to subtract setbacks from the buildable area of your land.



Slider dials
These controls are used to choose wants and Musts. To use a slider dial, click on the dial and 
while holding down your mouse button, move the dial to the right. After moving the dial, the 
dial will show the significance of its current setting. If the dial displays a number, then the 
number is the priority of your want (1= low priority, 9 = high priority, a zero means no 
preference). If the dial shows an 'M' then you have set a "Must."

If you 'Must' have an item, then slide its dial all the way to the right. For example:

If you 'want' an item, then slide its dial to set a priority of your want (1 = low priority, 9 = 
high priority).

If the item doesn't matter to you, then let its priority stay at zero. For example:



Specifications
Is a summary of information about the home. This information can be seen by printing a 
report for a home. You can also see more detailed specifications in the View screen by 
clicking on the specifications button.



Tour of Homes
The "Tour of Homes" slide show is an excellent way to attract attention to your business at 
trade shows, parade of homes, home shows, or other events. The music and special effects 
will attract peoples attention and draw them into your booth. Also, we'd like to help you. 
Sometimes we'll provide a free CD-ROM to raffle off at your event. This would encourage 
even more traffic to your booth and you'll benefit by having a record of the potential 
customers who attended your booth. For more information, read the article called Attracting 
New Customers found in the Getting Down to Business section of this Help.





Wants
When an item is a 'want', then the item is something you would like to have but the item 
isn't required. We sort the homes that are found based on your wants. Homes that have 
more ‘wants’ and higher priority 'wants' will be shown to you first. Because of this sorting, 
your favorite home will likely be one of the first homes you are shown. If an item is required 
you can make it a Must instead of a want.



Zoom
You can magnify pictures in the View area by clicking your left mouse button on the picture. 
Also, to zoom into a specific area, you can draw a box around that area while holding down 
your left mouse button. To zoom out, click on the right mouse button.






